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About This Document

This deployment guide is intended for system administrators and engineers. It includes instructions

for installation and configuration of ABBYY Timeline 5.1 on Windows.
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Introducing ABBYY Timeline

ABBYY Timeline is a process intelligence platform comprising over 25 process analysis tools. More

than a mere process tracker, ABBYY Timeline will monitor all events within your company in real

time and build a detailed map of each process, all while maintaining the flow of your business.

ABBYY Timeline employs an exciting new patent-pending approach to process intelligence called

Timeline Analysis which allows users to load events from a variety of systems and in different

formats which it then automatically organizes into its corresponding process instances and allows

them to be analyzed with a variety of visualization, discovery and query techniques. ABBYY

Timeline accepts event data from any number of systems of record and automatically reconstructs

the underlying business process logic behind the data. A variety of pre-built analyses are ready to

quantify your process performance, identify your process execution issues and perform root cause

analysis. The ABBYY Timeline platform also supports operational monitoring through its continuous

assessment of new event data to determine if any adverse conditions occur and can immediately

notify you or other business operations personnel so you can act.

The ABBYY Timeline engine consumes data from a variety of sources to detect and present

detailed views of your business processes. This is often the same exact data being used today for

other simpler analyses. This new insight is delivered via a variety of new process and timeline

visualization tools developed to not only make these new insights easier to understand but also to

allow users to manipulate the information to gain a deeper understanding of those processes.

Users armed with this insight have concrete facts on which to take actions to improve operational

efficiency by promoting clearly superior best practices and eliminating costly inefficiencies that

previously went undetected.

Using advanced algorithms, ABBYY Timeline extracts and reads the time stamps used to record

specific events along your processes. The software then visually models these time stamps in such

a way that you can instantly identify deviations from an ideal process flow – to find the root cause

of a problem that may be costing your business money.

ABBYY Timeline is aimed for use by anyone involved in business process improvements of any

type of scale or nature.
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ABBYY Timeline Components

ABBYY Timeline comprises the following components:

1. ABBYY Recording Service

Includes database and website. It is delivered as a separate distribution kit.

2. ABBYY Recorder

Includes recorder, ABBYY Recorder Log Viewer and browser extensions for Google

Chrome, Mozilla Firefox and Microsoft Edge. It is delivered as a separate distribution kit.

3. ABBYY Timeline

Includes databases and website. You can obtain the component in one of the following

ways:

a. Installation Package

You can purchase a license and download distribution kit via the links you got from

ABBYY sales representative. 

b. Online subscription

You can purchase a subscription to the ABBYY Timeline deployed in the cloud.

The purpose and functions of platform components are described in the table below.

Component Functions

ABBYY Recording Service Recording Service collects user interaction logs from multiple users

over time and allows to submit obscured data into ABBYY Timeline

ABBYY Recorder Captures all the variations of how desktop user tasks are performed. 

ABBYY Recorder Log

Viewer

Allows user to view the logs recorded by the ABBYY Recorder.

For detailed information on usage of Log Viewer, see 'ABBYY

Recorder Log Viewer Guide'.

ABBYY Timeline Analyzes desktop user interaction data and seamlessly links it with

process details mined from system event data, so you can see where

repetitive and inefficient tasks are slowing your processes and allocate

resources in the right places to resolve them.
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Getting Started

Ready to deploy? The instruction below walks you through deploying ABBYY Timeline system,

step-by-step.

Step 1. Make sure your computers are ready for ABBYY Timeline system

Before you begin installing ABBYY Timeline system:

1. Check the system requirements . 

These requirements help you know whether your computers support ABBYY Timeline

components.

2. Apply the latest Windows and other programs updates.

These updates ensure that your computer has the latest security updates.

3. Reboot.

The reboot ensures that any pending installs or updates don't hinder the ABBYY

Timeline components install.

4. Free up space.

Remove unneeded files and applications from your %SystemDrive%, as well as discs that

you intend to use, for example, to store the ABBYY Timeline databases.

5. If you intend to configure HTTPS, please visit the 'Using HTTPS ' section.

Step 2. Install ABBYY Recording Service component

1. Run the ABBYY.RecordingService.<version>.exe file and follow the on-screen

instructions in the Installation Wizard.

If you receive a User Account Control notice, choose Yes.

2. Specify the necessary network settings .

3. Make sure the ABBYY Recording Service component has been installed correctly by

performing a health check on ABBYY Recording Service .

Please refer to the 'Installing ABBYY Recording Service ' section for guidelines.

12
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49

28

24
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Step 3. Install ABBYY Timeline component

If you are going to use ABBYY Timeline in the cloud, please, skip this step.

Important. ABBYY Recording Service and ABBYY Timeline components must be installed on

separate computers.

1. Run the ABBYY-Timeline-5.1.*-installer.exe file and follow the on-screen instructions

in the Installation Wizard.

If you receive a User Account Control notice, choose Yes.

2. Specify the necessary network settings .

3. Make sure the ABBYY Timeline component has been installed correctly by performing a

health check on ABBYY Timeline .

Please refer to the 'Installing ABBYY Timeline ' section for guidelines. 

Step 4. Establish the trust relationship between ABBYY Recording

Service and ABBYY Timeline

For interaction between ABBYY Recording Service and ABBYY Timeline components, OAuth must

be configured .

1. Register ABBYY Recording Service as a client on the ABBYY Timeline website and obtain

credentials (Client ID and Client Secret).

Please refer to the 'Registering a New Client on ABBYY Timeline website ' section for

guidelines.

2. In the ABBYY Recording Service website specify the connecting details to ABBYY

Timeline using the credentials you obtained in step 1.

Please refer to the 'Configuring connection setting in ABBYY Recording Service '

section for guidelines. 

Step 5. Install ABBYY Recorder on users' computers

Important. The user workstations installing the ABBYY Recorder component, and the server

hosting the ABBYY Recording Service component must all be members of the same Active

Directory domain. 

49
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1. Install the Recorder on the users' workstations using the method of your choice.

Please refer to the 'Installing ABBYY Recorder ' section for guidelines. 

2. Turn on ABBYY Recorder extensions on the workstations.

Please refer to the 'How to Turn ABBYY Recorder Chrome Extension on ' section for

guidelines. 

Now you have all the ABBYY Timeline system components installed, and you can start working with

it.

Step 6. Start working

After Timeline system installation is complete, it must be configured.

1. Open ABBYY Recording Service website and configure settings:

a. Go to Settings and make sure the connection to ABBYY Timeline is established.

Please refer to the 'Administering' >'Using OAuth to Access ABBYY Timeline' >

'Configuring connection setting in ABBYY Recording Service ' section for

guidelines.

b. Go to Templates and click Default in the Template name column. Review and

modify the options if needed.

In the template, you can specify what data to register and how to process it. Please

refer to the 'How to Configure and Apply Template ' section for guidelines.

c. Go to Recorders.

You will see the list of connected recorders that were installed in Server managed

mode. Installed in this mode, recorders are automatically added to the Recorders

list.

d. Select a recorder and click Start.

This starts recording all user's desktop events to log.

e. Go to Logs

All recorded events are collected into logs and available in the Logs tab.

Note. The logs may take some time to process. We recommend you wait a while

before starting to work with the logs.

2. Open ABBYY Timeline website to create a new project or open an existing one with

enabled Task Mining data source.

(click Project > Details > Data sources and select Task Mining).

30
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3. Submit logs to the ABBYY Timeline from the ABBYY Recording Service:

a. Open the ABBYY Recording Service website.

b. Go to the Logs tab.

c. Select logs and click Load to project.

This will open ABBYY Timeline login form. Enter your credentials.

Note. Once you provide credentials, the program will no longer ask for them when

upload logs.

d. You will see the project list available for upload.

e. Click the project ID, then click Select.

f. All selected logs will be queued for upload.

Information about the upload process displays in the message box.

You can abort the upload by clicking Cancel. 

Note. It is impossible to cancel the upload of logs that have already been submitted

to ABBYY Timeline by the moment of cancellation. Such logs will be available for

work on the ABBYY Timeline website.

4. Uploaded logs are available for cutting and transforming in the ABBYY Timeline project

created or opened in step 2 .10
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System Requirements and Prerequisites

Important. 

· ABBYY Recording Service and ABBYY Timeline components must be installed on separate

computers.

· For interaction between ABBYY Recording Service and ABBYY Timeline components, you

must use the same protocol, for example, HTTP and HTTP, or HTTPS and HTTPS. If you

are going to use ABBYY Timeline in the cloud, please, use HTTPS.

· The user workstations installing the ABBYY Recorder component, and the server hosting

the ABBYY Recording Service component must all be members of the same Active

Directory domain. 

ABBYY Timeline

Operating system Microsoft® Windows Server® 2019

CPU 4 cores or more

RAM 16 GB or more

HDD 512 GB or more

Depends on the actual amount of data loaded into the application.

Production environment may require more disk space, depending on the

actual volume of data loaded into the application.

Browser

(to access the

ABBYY Timeline

website)

· Google Chrome 92.0 or later

· Microsoft Edge 93.0 or later

Additional

software

Additional Requirements for Windows

· Microsoft Windows Subsystem Linux

If this Windows feature is disabled, the ABBYY Timeline Setup will prompt

you to enable it. After that, you will need to restart your computer to apply

the changes.
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· Redis 5 for Linux

ABBYY Timeline uses Redis for Linux therefore additional software is

needed. Please, download the following installation packages into the same

folder:

o Linux Ubuntu 20.04 LTS (Ubuntu_2004.2020.424.0_x64.appx)

o gcc-10-base_10.3.0-1ubuntu1_20.04_amd64

o libatomic1_10.3.0-1ubuntu1_20.04_amd64.deb 

· Microsoft .NET Framework 4.5*  

· PostgreSQL 12.*  

· NodeJS 14.16.1*  

· ImageMagick*  

· Python 3.8.10. (64-bit)*  

· Microsoft Visual C++ Runtime 14.0 update 3*  

· SMTP Server

The ABBYY Timeline needs access to a running SMTP server to be able to

send verification emails, notifications, invitations, and alerts, etc.

* included with the ABBYY Timeline installer.

Scaling guidelines

The exact calculation of necessary hardware requires multiple parameters such as data volume and

use patterns. However, the general guidelines could be defined as following:

· If the number of concurrent users is less than 10 and the data update frequency is one

per day or less, a single server should be sufficient.

· For more users or more frequent data updates, a separate server for DBMS is

recommended.

· For the fault-tolerant environment, use two identical servers and any standard load

balancer.

13

13

13

13

13

13

https://docs.microsoft.com/en-us/windows/wsl/install-manual
http://security.ubuntu.com/ubuntu/pool/main/g/gcc-10/gcc-10-base_10.3.0-1ubuntu1~20.04_amd64.deb
http://security.ubuntu.com/ubuntu/pool/main/g/gcc-10/libatomic1_10.3.0-1ubuntu1~20.04_amd64.deb
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ABBYY Recording Service

Operating system Microsoft® Windows Server® 2016 or 2019

Additional

software

· Microsoft® Internet Information Services (IIS) 8.5*

· ASP.NET Core Hosting Bundle*

· IIS CORS Module*

· PostgreSQL v. 12 or later*

Browser

(to access the

ABBYY Recording

Service website)

Google Chrome 92.0 or later

Other

requirements

1.  The ABBYY Recording Service works with ABBYY Timeline 5.1

2. Computer you intend to install ABBYY Recording Service component must

be a member of Active Directory domain.

You may use an existing security group or create the following security

groups in Active Directory:

o Recording Service admin group, e.g., Recorder-admin

Assign this group full control to the ABBYY Recording Service web

application. Then add user accounts to the group to grant them admin

access to the ABBYY Recording Service web application.

o Recorder writers, e.g. Recorder-writer

Assign this group write access to the ABBYY Recording Service. Then add

user accounts to the group to grant their ABBYY Recorder instances read

access to the ABBYY Recording Service web application. This will allow

ABBYY Recorder instances to send logs to the ABBYY Recording Service.

Note. You may use a user account, a domain or local group, or a built-in

group for testing purposes. For more information, see the 'Installing ABBYY

Recording Service ' section.

* included with the ABBYY Recording Service installer. 

14

14

14
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https://www.iis.net/downloads/microsoft/iis-cors-module
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Hardware configuration example

If recording is done for 10 employees during 4 weeks (1 person generates approximately 5000 UI

events per day):

· Operating system: Windows Server 2016

· CPU: 8 cores or more

· RAM: 16 GB or more

· Hard disk space: 256 GB HDD/SSD

· Logs with screenshots require approximately 200 GB

ABBYY Recorder

Operating system Microsoft® Windows 10 (x64)

Additional

software

Microsoft .NET Framework 4.6.2*

Browser

(to record user

activities)

· Browser Google Chrome 92 or later

Important. The following versions are not supported:

o Google Chrome Portable

o Google Chrome Standalone for one user

o Google Chrome Standalone for multiple users

· Microsoft Edge 92 or later

· Mozilla Firefox 90 or later (Limited support. See Known Issue  for details)

Important. Mozilla Firefox ESR is not supported

Other

requirements

ABBYY Recorder works with ABBYY Timeline 5.1 and the ABBYY Recording

Service that comes with Timeline 5.1.

* included with the ABBYY Recorder installer. 

15

65
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Installation, Removal and Upgrade

This section provides instructions for installing the ABBYY Timeline components, upgrading, and

removing them from your computers.

ABBYY Timeline

This section contains information about installing and removing ABBYY Timeline.

If you are going to use ABBYY Timeline in the cloud, please, skip this chapter.

Installing ABBYY Timeline

Important. The ABBYY Timeline installer does not have a repair mode. Please do not edit/delete

anything in the installation folder unless you have received clear instructions on what to do. In case

you deleted something from the installation directory by accident, you will have to uninstall, then

re-install ABBYY Timeline.

To perform all activities below, you must be a system administrator of the computer on which

ABBYY Timeline is being installed.

Interactive installation

Run the ABBYY-Timeline-<version>-installer.exe file and follow the on-screen instructions in the

Installation Wizard. 

The Installation Wizard will display a sequence of pages with detailed instructions for each

installation step. Use the Back and Next buttons to navigate the pages. To quit the Installation

Wizard at any stage, click Close. 

1. License Agreement 

Read and accept the license agreement.

2. Check and install prerequisites

After the license agreement is accepted, Setup checks third-party applications that are

required to configure and operate ABBYY Timeline. Some of the applications you must

download and install manually. If your computer meets the system requirements, the

steps described in this paragraph will not show.



17© 2021 ABBYY Development Inc. 

ABBYY® Timeline 5.1 - Deployment Guide

a. Enable Windows Features

If this Windows feature is disabled, the ABBYY Timeline Setup will prompt you to

enable it. After that, your computer will be restarted automatically. Please save your

work before continuing the installation. After restarting, the Timeline installation will

be auto-resumed. If it doesn't run automatically, please run the ABBYY-Timeline-

<version>-installer.exe file again.

b. Redis installation

i. Download the following installation packages into the same folder:

- Linux Ubuntu 20.04 LTS (Ubuntu_2004.2020.424.0_x64.appx)

- gcc-10-base_10.3.0-1ubuntu1_20.04_amd64.deb

- libatomic1_10.3.0-1ubuntu1_20.04_amd64.deb 

ii. Source Folder 

Specify a folder where you place packages specified above. 

iii. Ubuntu Installation Folder

Specify a folder where Ubuntu will be extracted to. The default folder is:

C:\Program Files (x86)\Ubuntu

3. Installation Folder 

You may select a destination folder. ABBYY Timeline will be installed into this folder. By

default, the component is installed into: C:\Program Files\ABBYY Timeline

4. Select Database

ABBYY Timeline needs access to the PostgreSQL database. You can install PostgreSQL

on a computer along with ABBYY Timeline or a separate computer.

If you already installed PostgreSQL on the current computer or another one, select the

Connect to existing database. Otherwise, select Install local database. Go to the next

step to specify database connection settings.

5. If you selected Install local database, provide all information in the Database

Connection step. See below for details. Otherwise, go to the next step for instructions.

a. Database Connection

Configure access to database.

i. PostgreSQL user and PostgreSQL password

Provide PostgreSQL superuser credentials. In case of installation local database,

these credentials will be used by the installation program to create a database

user for the ABBYY Timeline.

https://docs.microsoft.com/en-us/windows/wsl/install-manual
http://security.ubuntu.com/ubuntu/pool/main/g/gcc-10/gcc-10-base_10.3.0-1ubuntu1~20.04_amd64.deb
http://security.ubuntu.com/ubuntu/pool/main/g/gcc-10/libatomic1_10.3.0-1ubuntu1~20.04_amd64.deb


18© 2021 ABBYY Development Inc. 

ABBYY® Timeline 5.1 - Deployment Guide

ii. PostgreSQL port

Specify TCP/IP port for the PostgreSQL. By default, TCP/IP port 5432 is used.

Make sure that it is not being used by any other application. For more

information, see the How to Check if the TCP/IP Port is Free  section.

iii. PostgreSQL host

If you select Connect to existing database on the previous step, specify server

name where PostgreSQL is installed. By default, localhost is used.

iv. Data directory

If you select Install local database on the previous step, enter the path where

the database needs to be installed.

The default path is: C:\Program Files\PostgreSQL\12

6. If you selected Connect to existing database, this means PostgreSQL is already

installed on the remote or local server.

Next, you need to configure the database connection settings. 

Important. Using SSL to connect to the database is not supported in this version. 

Note. If the Timeline database already exists on the specified PostgreSQL server and the

PostgreSQL version is supported, the Review Database Configuration step will open.

Select Connect to the existing Timeline database if you want ABBYY Timeline to

connect to the detected database. Otherwise, select Reinstall Timeline database

tables and user. In this case, the installer will delete the detected database and install a

new one.

7. ABBYY Timeline Admin User Account 

Enter a valid email address using an existing domain name that is configured to receive

emails, for example, user@domain.com, and a password. This will be the first user and

the one that will have access to the ABBYY Timeline website, where other users can be

administered.

The password you specified must contain only English letters and digits from 0 to 9. It

must be at least eight characters long, contain at least one uppercase letter, one

lowercase letter, and one number.

49

mailto:user@domain.com
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8. Mail Server Configuration

Configure the SMTP server access to be able ABBYY Timeline sending out emails in

several features such as Alerting, User invitation, Email verification, etc. For example,

during a user registration process, user's email is checked. A verification email message

is sent to the user. User won't be able to use ABBYY Timeline until he completes the

instructions contained in the message.

a. Mail server host

Specify server name where SMTP mail server is installed.

b. Mail server port

Provide SMTP mail server port number.

c. Mail server username and Mail server password

Provide SMTP mail server access credentials.

d. Email sender

Provide the e-mail sender address is used to fill the 'From' header field of e-mails. 

e. Mail server security

Specify mail server security options. To decide which option you have to select, refer

to the documentation of your mail server. Mail server basic settings are set during

installation. You can change SMTP Mail Server configuration after installation. For

more information, see 'Change SMTP Mail Server Configuration'  section.

i. Select Non secure in case of SMTP server does not use TLS. 

It is a typical use case for mock, local mail services, for example, mailcatcher.

ii. Select Require TLS after connection if the initial connection should happen over

an unencrypted connection and then the STARTTLS command should be used to

upgrade to a secure connection. For example, Microsoft Exchange.

iii. Select Secure from the start of the connection then the app will use TLS to

connect to the SMTP server from the start. It is the most secure option, however

not all mail servers support this option. 

iv. Select Allow self-signed certificate if your mail server uses an unauthorized, e.g.,

self-signed, SSL certificate.

9. Timeline Base URL and Ports Configuration

a. Enter the Base URL that hosts the ABBYY Timeline. 

Base URL must be a fully qualified URL. It should match the computer name on which

you are installing ABBYY Timeline and must be accessible both from the computer on

51
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which the ABBYY Recording Service component is installed and from the

administrator browser. It also is used for links inside email messages sent by the

ABBYY Timeline. 

Note: Users will be able to get to the ABBYY Timeline website using the Base URL. 

The Base URL must have the following syntax: http[s]://hostname:port

The lowercase pattern is recommended. If you are using the default port (80 or 443),

you do not need to add them to the base URL

Examples:

The base URL of the HTTP endpoint, if a custom port is specified:
http://mytimeline.com:8080

The base URL of the HTTPS endpoint, if a custom port is specified:
https://mytimeline.com:30443

b. Specify TCP/IP port for the ABBYY Timeline website. 

By default, TCP/IP port 80 is used for the ABBYY Timeline website. Make sure that it is

not being used by any other website. For more information, see the 'How to Check if

the TCP/IP Port is Free ' section. You can also set a different port number later .

Select Use HTTPS if you want to secure data transferred. For setting up HTTPS you

will be asking for the SSL certificate and the private key. Currently, the ABBYY

Timeline does not accept .pfx files. In case you have a .pfx file, you should convert it

to .key and .cert files. The key and certificate files must be named server.key and

server.cert since the ABBYY Timeline accepts only files with these names.

Important.

§ If you install the program in a production environment, it is strongly

recommended to use HTTPS and highly discouraged HTTP. 

§ For interaction between ABBYY Recording Service and ABBYY Timeline

components, it is recommended to use the same protocol, for example, HTTP

and HTTP or HTTPS and HTTPS. Make sure that during the ABBYY Timeline

installation you specify the same protocol as specified when installing the

ABBYY Recording Service.

10.Service Setup 

Specify user credentials under which ABBYY Timeline service will run. Provide the login

in the format of 'domain\user'. The following options are available:

49 50
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a. If the computer is an Active Directory domain member, you can specify

i. Domain user account.

Login example: MYDOMAIN\username

ii. Local machine account

Login example: MYCOMPUTERNAME\username

b. If the computer is part of or workgroup, specify local machine account

Login example: MYCOMPUTERNAME\username

Installer does not create any software or hardware firewall exceptions. You must set up exception

settings to allow interactions between components to take place inside a network. For example,

you create inbound and outbound rules in Windows Firewall. For detailed information, see

'Network connection settings ' section. 

During the installation process, the following PostgreSQL database tables are created:

· timeline 

The database contains all information about users, their activity, and projects.

· timeline-log

The database contains detailed records of ABBYY Timeline events such as security, errors,

and notifications.

· timeline-000

The database contains information about user repositories.

Performing health check

Check that ABBYY Timeline is working properly by doing the following:

1. Open a browser and enter {timelineURL}:{port} in the address bar, where:

· {TimelineUrl} is the Base URL you specified during ABBYY Timeline installation or

the public IP address or the full name of the computer on which the ABBYY

Timeline is installed. 

· {port} is the custom port assigned to the ABBYY Timeline website during the

installation

process. If you are using the default port (80 or 443), you do not need to add them

to the {timelineURL}. By default, TCP/IP port 80 or 443 is used.

Example: http://mytimeline:8080 or https://mytimeline:30443 
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2. If the installation was carried out correctly, the ABBYY Timeline website will open.

3. Login using the ABBYY Timeline admin credentials you specified in step 4 "Admin User

Account" during the ABBYY Timeline installation process .

Upgrading ABBYY Timeline

If you own ABBYY Timeline 5.0 or later, you can upgrade to ABBYY Timeline 5.1. This means that

you can install a new version of ABBYY Timeline and your databases will be maintained.

Note. To upgrade Timeline 4.8 or 4.11, ensure that all the following conditions are in place:

1. PostgreSQL 9.6 database is on the current computer.

2. PostgreSQL 12 is not installed yet.

3. Installation must be run interactively. Command line installation can't be used for

upgrade.

Before you begin

We recommend you backup the Timeline database. To do this, use PostgreSQL utilities. It includes

utilities that allow you to make backups. These are pg_dump/pg_dumpall and pg_basebackup.

For detailed information, see https://www.postgresql.org/docs/12/backup.html.

Basic steps

1. Run the ABBYY-Timeline-5.1.*-installer.exe file to start the Installation Wizard.

2. In the program dialog box, select Update and follow the instructions of the Installation

Wizard.

Important. Upgrading within the same version is not supported.

If you can't upgrade ABBYY Timeline using the Setup, perform the following steps:

1. Uninstall your ABBYY Timeline

§ If you uninstall ABBYY Timeline 4.8, your databases are maintained while uninstalling,

but the previous settings are removed.

18

https://www.postgresql.org/docs/12/backup.html


23© 2021 ABBYY Development Inc. 

ABBYY® Timeline 5.1 - Deployment Guide

§ If you uninstall ABBYY Timeline 4.11 or late, you will be asked whether you want to

uninstall the product completely or maintain the databases.

2. Run the ABBYY-Timeline-5.1.*-installer.exe file and follow the on-screen instructions

in the Installation Wizard.

3. Perform a health check .

Uninstalling ABBYY Timeline

1. Run the ABBYY-Timeline-5.1.*-installer.exe file to start the Installation Wizard.

2. In the program dialog box, click Uninstall ABBYY Timeline.

3. In the next dialog box specify whether you want to uninstall the product completely or

maintain the databases for future use (e.g., if you choose to install a newer version). 

§ If you want to remove the Timeline product completely, including the databases,

select Delete ABBYY Timeline database and data folder and provide PostgreSQL

superuser credentials.

§ If you want to uninstall the Timeline product while keeping the databases, proceed to

the next step.

4. Click Uninstall to start the removal process.

While product removal is still in progress, you have the option of canceling it by clicking

Cancel.

5. Once the product is removed from your system, click Finish to close the Installation

Wizard.

Important. After the ABBYY Timeline is removed, you must restart the computer.

ABBYY Recording Service

This section contains information about installing and removing ABBYY Recording Service.

21
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Installing ABBYY Recording Service

Interactive installation

Run the ABBYY.RecordingService.<version>.exe file and follow the on-screen instructions in the

Installation Wizard:

1. Destination Folder 

Specify installation folder and TCP/IP port to be used ABBYY Recording Service website:

a. Folder path

Specify a folder into which ABBYY Recording Service should be installed. The default

installation folder is:

C:\inetpub\ABBYY Recording Service

b. Web site port 

Specify TCP/IP port to be used by the ABBYY Recording Service website or keep the

default value.

By default, the following TCP/IP ports are used:

· 443 (if use HTTPS)

For setting up HTTPS you will be asking for the SSL certificate and the private key.

· 80 (if use HTTP)

The Default Web Site is running on port 80. If you plan to use port 80 for the

ABBYY Recording Service website, you may need to modify this port from 80 to a

different one in the Internet Information Services (IIS) Manager. 

Make sure that specified port is not being used by any other application. In the event

of port conflict, an alert will be displayed. Change the port number to continue. For

more information, see the 'How to check if the TCP/IP port is free ' section. You

can also set a different port number for the ABBYY Recording Service website later.

To do this, change the port number in the Internet Information Services (IIS)

Manager.

Note: For interaction between ABBYY Recording Service and ABBYY Timeline

components, it is recommended to use the same protocol, for example, HTTP and

HTTP or HTTPS and HTTPS. Make sure that during the ABBYY Recording Service

installation you specify the same protocol as specified when installing the ABBYY

Timeline. If you are going to use ABBYY Timeline in the cloud, please, use HTTPS. 
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If you install the program in a production environment, it is strongly recommended

to use HTTPS and highly discouraged HTTP. 

2. AD Security 

ABBYY Recording Service uses Windows authentication. For interaction between ABBYY

Recording Service and Recorders installed on user workstations, the authentication

mechanisms are used as well. In the AD Security window, fill in:

a. Admin AD Security group

Members of this group obtain admin access to the ABBYY Recording Service website.

b. Recorder AD Security group

Members of this group obtain write access to the ABBYY Recording Service

component. Both local and Active Directory groups and accounts can be used.

If you install the program in a production environment it is recommended to specify

an existing Active Directory security groups or groups you created before the

installation , e.g., Recorder-admin and Recorder-writer.

For testing purposes, you may specify a user account(s):

o Domain user

Format: Domain\UserName

To display the domain and username of the person who is currently logged on to

the computer, open the Command Prompt (Start > Run > cmd) and type

whoami.

o Local group or user

Format: ComputerName\GroupName or ComputerName\UserName

To display the computer name, open the Command Prompt (Start > Run >

cmd) and type hostname.

Note. You may create a local group, add domain users or groups to it, and

specify this group to the Admin AD Security group field.

o Everyone, if you do not want to restrict access to the ABBYY Recording Service

website

Format: Everyone

12
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You can change AD Security Groups configuration later. For more information, see the

'How to Change AD Security Groups that Have Access to the ABBYY Recording Service

Resources ' section. 

3. PostgreSQL Database Options 

ABBYY Recording Service needs access to the PostgreSQL database. You can install

PostgreSQL on a computer along with ABBYY Recording Service or a separate

computer.

If you already installed PostgreSQL on another computer, select the Connect to

remote / another preinstalled version of PostgreSQL database. Otherwise, select

Install PostgreSQL on this machine.

Note. If PostgreSQL 12 is already installed on the current computer, instead of the

PostgreSQL Database Options step, the Database Connection step will open. In this

step, you need to specify the settings for connecting to the database.

a. Install PostgreSQL 12 on this machine 

Allows you to install PostgreSQL and database on the local machine. 

i. Go to the next step to specified PostgreSQL accounts and port to install

PostgreSQL locally.

o Super user account

§ Provide PostgreSQL superuser credentials and the PostgreSQL port number.

These credentials will be used by the installation program to create a database

user for the ABBYY Recording Service.

Important. The PostgreSQL superuser name may contain only English letters

and digits from 0 to 9 may not include any of the following characters: - \ /: *?

"<> |

§ Specify TCP/IP port for the PostgreSQL. By default, TCP/IP port 5432 is used.

Make sure that it is not being used by any other application. For more

information, see the 'How to check if the TCP/IP port is free ' section.

o Service account 

By default, the PostgreSQL services operate under the superuser account. To

change the default user, select Specify service user credentials option and set

new credentials for running the PostgreSQL service.

Important. The Service account name may contain only English letters and digits

from 0 to 9 may not include any of the following characters: - \ /: *? "<> |
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o Port

Specify TCP/IP port for the PostgreSQL. By default, TCP/IP port 5432 is used.

Make sure that it is not being used by any other application. For more

information, see the How to Check if the TCP/IP Port is Free  section.

ii. Go to the next step to specify PostgreSQL destination folders:

o Installation Directory

PostgreSQL will be installed into specified folder. The default installation folder is:

C:\Program Files\PostgreSQL\12

o Data Directory

Enter the path where the database needs to be installed.

The default path is: C:\Program Files\PostgreSQL\12\data

iii. Go to the next step of the Installation Wizard to specify PostgreSQL database

name and user that will work with ABBYY Recording Service and database.

b. Connect to remote / another preinstalled version of PostgreSQL database 

Allows you to specify connection settings to the existing database.

Go to the next step to specify database connection configuration.

4. After the Recording Service installation is complete, change the RecordingService app

pool's idle timeout using IIS Manager:

a. Select Application Pools in the Connections panel.

b. Right-click the RecordingService app pool in the list and select Advanced Settings.

c. The default Idle Time-out (minutes) is 20 minutes. Set the Idle Time-out (minutes) to

0 (zero). 

d. Click OK.

e. Recycle the worker process.

For details, see the Microsoft instruction: https://docs.microsoft.com/en-

us/aspnet/core/host-and-deploy/iis/?view=aspnetcore-2.2#idle-timeout-1

During the installation of the ABBYY Recording Service, a shortcut to the ABBYY Recording Service

site is added to the start menu.

Important. If you are using a software or hardware firewall, make sure that the configured ports

are open in your firewall. For default network connection settings see 'Network connection

settings ' section. 
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Performing health check

To perform a health check on ABBYY Recording Service:

1. Go to Start menu > ABBYY Recording Service 

ABBYY Recording Service website will open in your browser.

2. If ABBYY Recording Service has been installed correctly, you will see the ABBYY

Recording Service Site with the default template.

Upgrading ABBYY Recording Service

If you own ABBYY Recording Service that comes along with ABBYY Timeline 5.0 or later, you can

upgrade to ABBYY Recording Service comes along with ABBYY Timeline 5.1. This means that you

can install a new version of ABBYY Recording Service, and your databases and logs will be

maintained.

Before you begin

It is recommended that you backup your ABBYY Recording Service database before you perform

upgrade. To do this, use PostgreSQL. It includes utilities that allow you to make backups. These are

pg_dump/pg_dumpall and pg_basebackup. For detailed information, see

https://www.postgresql.org/docs/12/backup.html.

Basic steps

1. Run the ABBYY.RecordingService.<version>.exe file to start the Installation Wizard.

2. Follow the instructions of the Installation Wizard.

If you can't upgrade ABBYY Recording Service using the setup, perform the following steps:

1. Uninstall your ABBYY Recording Service.

Your database is maintained while uninstalling.

2. Run the ABBYY.RecordingService.<version>.exe file to start the Installation Wizard.

3. Follow the instructions of the Installation Wizard.

https://www.postgresql.org/docs/12/backup.html
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4. To connect to the existing database, you must provide existing values in step Database

Connection.

5. User login and User password

Specify PostgreSQL superuser credentials.

a. Server name

Specify server name where PostgreSQL is installed.

b. Port

Specify TCP/IP port for the PostgreSQL.

6. In the Create Database step specify:

a. User to create

It is a username that will be used for interaction between ABBYY Recording Service

and PostgreSQL database.

Important. During every new installation, you must specify a new username. 

b. Database name

Specify a database name. Installer will assign the database to the specified user.

Note. If you enter the name of a non-existent database, the installer will create a new

database with the specified name.

Uninstalling ABBYY Recording Service

1. Open Control Panel -> Programs -> Programs and Features and select ABBYY

Recording Service. 

2. Click Uninstall.

3. In the Installation Wizard select Uninstall and follow the instructions of the Wizard.

Note. Your database and recorded logs are maintained while uninstalling.

ABBYY Recorder

This section contains information about installing and removing ABBYY Recorder.
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Installing ABBYY Recorder

Before you begin

Before you begin installing ABBYY Recorder, pay attention to the following items:

1. The user workstations installing the ABBYY Recorder component, and the server hosting

the ABBYY Recording Service component must all be members of the same Active

Directory domain. 

2. Add user accounts, whose computers you intend to install ABBYY Recorder, to the

Recorder writers Active Directory security group you created before the installation .

3. If the extensions are not installed, user activities are not recorded in Google Chrome,

Microsoft Edge, and Mozilla Firefox browsers.

4. ABBYY Recorder Firefox extension has several limitations. Please refer to the 'Known

issues' > 'ABBYY Recorder Firefox extension limitation ' section for detailed

information.

Interactive installation

Run the Abbyy.Recorder.<version>.exe file and follow the on-screen instructions in the

Installation Wizard.

1. Application Folders 

a. Installation folder

ABBYY Recorder will be installed into this folder. The default installation folder is:

C:\Program Files\ABBYY Recorder

b. Data folder 

Specify a local or network folder where the program will store its data. To keep data

in %appdata%\ABBYY\Recorder\ folder, select Use AppData folder.

Depending on the operating mode, which is set in the next installation step, different

data are stored in the specified folder: 

i. When installed in Standalone mode, application logs and logs with recorded user

activity are stored there.

12
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ii. When installed in Server managed mode, only application logs are stored there.

2. Installation Details

a. Tag

You may specify a tag. Tag is simply some text string that describes the current

workstation with your ABBYY Recorder instance. When installing in Server managed

mode tag is passed to the ABBYY Recording Service and helps the administrator

identify a workstation in the ABBYY Recording Service website. Username is not

recommended as a tag because several users could occupy the same workstation.

For example, you can specify the same tag when installing ABBYY Recorder on

several workstations, e.g., the 'accounting department' tag. Then you can easily find

these workstations in the Recorders list on the ABBYY Recording Service website by

the 'accounting department' tag.

b. Operation mode

Select the ABBYY Recorder operation mode:

i. Standalone 

When this mode is on:

§ Recording control (start/stop) remains with the local computer.

§ The logs with the recorded data are saved on the local computer. 

§ Setup installs the ABBYY Recorder Log Viewer utility. The utility allows opening

the logs recorded by the Recorder installed in Standalone mode.

For detailed information on usage of ABBYY Recorder Log Viewer, see 'ABBYY

Recorder Log Viewer Guide'.

Important. Standalone mode is useful for trial purposes. It has the following

restriction:

· The feature Obfuscate user data does not apply to screenshots. This means

records in text logs are encrypted, but data in screenshots aren't blurred.

· Logs are not processed and not sent to ABBYY Recording Service. Thus, it is

impossible to use ABBYY Recording Service to review recorded data and upload

logs to ABBYY Timeline. You'll need to upload collected logs directly to ABBYY

Timeline manually. For detailed information see 'How to Upload Logs to Timeline

from a Recorder Installed in Standalone Mode ' section.62



32© 2021 ABBYY Development Inc. 

ABBYY® Timeline 5.1 - Deployment Guide

i. Server managed 

When this mode is on, the recording control (start/stop) can be performed from

the ABBYY Recording Service. User activity logs are automatically saved to the

server.

Specify the URL on which ABBYY Recording Service is installed and accessible over

Network. 

3. Installation Option 

Select browser extensions you want to install. Extensions allows ABBYY Recorder to

capture user actions in the Google Chrome, Microsoft Edge and Mozilla Firefox

browsers.

Note. ABBYY Recorder Firefox extension has several features. Please refer to the 'Known

issues' > 'ABBYY Recorder Firefox extension limitation ' section for detailed

information.

After ABBYY Recorder is installed on users' computers, each user must enable extensions in

browser. Below you will find instructions on how to enable the extension in Google Chrome ,

Microsoft Edge , and Mozilla Firefox .

Note. If a user has just been added to the Recorder-writer Active Directory group , you may

need to restart the computer. This allows Recorder installed in Server managed mode to connect

to Recording Service.

Command line installation

You can install the ABBYY Recorder components in silent mode using the command line. For silent

installation, type: 

Abbyy.Recorder.<version>.exe /silent

You can use the following command-line options described below.

Option Default Value Description

/silent Runs the installation in silent mode.

In the case of silent installation, no setup

dialog boxes are displayed, and the

program is installed in default

configuration.
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Option Default Value Description

/passive Runs the installation with the progress bar

only to be displayed. No other dialog

boxes will be displayed.

installDir=<path> C:\Program Files\ABBYY

Recorder

The path to the folder where ABBYY

Recorder will be installed.

DataPath=<path> %appdata%\ABBYY\Recorder Folder where the program will store its

data. 

Depending on the operating mode,

different data are stored in the specified

folder: 

· If you specify ServerUrl  value to

install ABBYY Recorder in Server

managed mode, only application logs

are stored there.

· If you install ABBYY Recorder in

Standalone mode, application logs and

logs with recorded user activity are

stored there.

Tag=<tag> Tag describing current workstation. No

tag is added by default.

ServerUrl=<server

URL>

Turns the Server managed on. Specify

the URL on which the ABBYY Recording

Service is installed and accessible over

Network. 

If this option is not specified, the default

installation is in Standalone mode.

ChromeExt=<true|

false>

true Installs ABBYY Recorder Chrome

extension.

EdgeExt=<true|false> true Installs ABBYY Recorder Edge extension.
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Option Default Value Description

FirefoxExt=<true|

false>

true Installs ABBYY Recorder Firefox extension.

Important. 

· ABBYY Recorder setup can install the

ABBYY Recorder Firefox extension only

under a current user account.

How to solve this issue see 'Known

Issues' > ABBYY Recorder Firefox

extension limitation  section.

· ABBYY Recorder setup cannot remove

the ABBYY Recorder Firefox extension.

Each user must remove the ABBYY

Recorder Firefox extension from

Mozilla Firefox manually. For more

information, see the 'How to Uninstall

ABBYY Recorder Firefox Extension '

section.

ControlButtonsVisible

=<true|false>

true Specifies the mode where most of the

standard UI is turned off.

ABBYY Recorder introduces a custom UI

option as an alternative to the classic UI. It

hides the Enable/Disable buttons from

the user interface when installed in Server

managed mode.

Important. it is highly discouraged to

install ABBYY Recorder with custom UI in

production environment.

For detailed instructions on installing

ABBYY Recorder with custom UI, see

below.

Example: Abbyy.Recorder.<version>.exe /silent installDir="C:\Recorder" DataPath="C:
\Data" Tag="RecorderWorkstation1" ServerUrl="https://myrecordingserviсe.com/"

FirefoxExt=false
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This command installs ABBYY Recorder to the C:\Recorder folder in Server managed mode with

the following settings:

· ABBYY Recorder Chrome and Edge extensions will be installed. Firefox extensions will not

be installed.

· Program logs will be store in the C:\Data folder. 

· Logs with a user activity will be sent to the ABBYY Recording Service hosted at

https://myrecordingserviсe.com/.

Installing ABBYY Recorder with custom UI

To install ABBYY Recorder with custom UI:

1. Uninstall your old version of ABBYY Recorder.

2. Install a new ABBYY Recorder 

Specify ServerUrl and ControlButtonsVisible=false at the command line.

Example: Abbyy.Recorder.<version>.exe /silent installDir="C:\Program
Files\ABBYY Recorder" ControlButtonsVisible=false

ServerUrl="https://myrecordingserviсe.com/"

Performing health check

Check that ABBYY Recorder has been installed properly by doing the following: 

· ABBYY Recorder icon appeared in the system tray.

· Open Chrome and make sure the ABBYY Recorder Chrome extension appeared in the

extensions list.

How to Enable Chrome Extension

To turn on the ABBYY Recorder Chrome extension, carry out the steps listed below on the

workstations.

Important. An internet connection is required on workstations.

1. Open or restart the Chrome.



36© 2021 ABBYY Development Inc. 

ABBYY® Timeline 5.1 - Deployment Guide

2. Click the menu button, click More tools, and then click Extensions.

The Extensions page appears.

3. Find the ABBYY Recorder extension in the list and select the Enable check box.

4. The ABBYY Recorder extension is now enabled.

How to Enable Edge Extension

To turn on the ABBYY Recorder Edge extension, carry out the steps listed below on the

workstations.

Important. An internet connection is required on workstations.

1. Open Microsoft Edge.

2. Click the menu button, and then click Extensions.

The Extensions page appears.

3. Locate the ABBYY Recorder extension in the list and move the slider to On.
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4. The ABBYY Recorder extension is now enabled.

How to Enable Firefox Extension

To turn on the ABBYY Recorder Firefox extension, carry out the steps listed below on the

workstations.

1. Open Mozilla Firefox.

2. Click the menu button and select Add-ons and Themes.

3. Click Extensions.

The Extensions screen appears.

4. Locate the ABBYY Recorder extension in the list and click Enable.

If the extension is not listed, it may not have been installed. How to install the extension

manually, see the 'How to install the Firefox extension in browser manually ' section.

5. The ABBYY Recorder extension is now enabled.

Important. In order for the ABBYY Recorder extension to work properly, the Firefox

browser and ABBYY Recorder must be run under the same account.

How to Install the Firefox Extension in Browser Manually

1. Open Mozilla Firefox.

2. Click the menu button and select Add-ons and Themes.

3. Click Extensions.

The Extensions screen appears.

4. Press Settings (gear icon) next to the add-on search bar and select Install Add-on

From File.

5. Select %ABBYY Recorder folder%\FirefoxExtension\abbyy_recorder-*.xpi and click

Open.

6. Your Firefox browser will ask you to install the ABBYY Recorder extension right now.

7. Click Add to allow the installation.
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Upgrading ABBYY Recorder

If you own ABBYY Recorder that comes along with ABBYY Timeline 5.0 or later, you can upgrade

to ABBYY Recorder comes along with ABBYY Timeline 5.1.

To upgrade ABBYY Recorder run the Abbyy.Recorder.<version>.exe file and follow the

instructions of the Installation Wizard.

During the upgrade process, the installer maintains all your previous settings.

Uninstalling ABBYY Recorder

This section contains information about removing ABBYY Recorder.

Uninstalling ABBYY Recorder via the Command Line

To uninstall ABBYY Recorder in silent mode via the command line, run:
Abbyy.Recorder.<version>.exe /uninstall /silent

Important. ABBYY Recorder setup cannot remove the ABBYY Recorder Firefox extension from the

Mozilla Firefox browser. If you have the ABBYY Recorder Firefox extension installed on

workstations, users must uninstall this extension from their Firefox browser manually. For detailed

information see 'How to Uninstall ABBYY Recorder Firefox Extension ' section.

How to Uninstall ABBYY Recorder Firefox Extension

After the ABBYY Recorder uninstallation is complete, each user must remove the ABBYY Recorder

Firefox extension from Mozilla Firefox manually:

1. Open Mozilla Firefox.

2. Click the menu button and select Add-ons and Themes.

3. Click Extensions.

The Extensions screen appears.

4. Locate the ABBYY Recorder extension in the list.

5. On the right side, click the ellipsis (3-dot) icon and select Remove from the drop-down

menu.
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About ABBYY Timeline Licenses

To purchase a license or subscription, please contact your local ABBYY sales representative or

ABBYY Timeline support at support@abbyy.com.

mailto:support@abbyy.com
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Administering

This section provides instructions for configuring the ABBYY Timeline components. 

Using OAuth to Access ABBYY Timeline

OAuth is an authorization protocol that allows granting one service (application) the right to access

user resources on another service. The protocol eliminates the need to pass the application a

username and password and allows a third-party application to gain limited access to an

application or service, on behalf of a resource owner.

For interaction between ABBYY Recording Service and ABBYY Timeline components, it is

recommended to register ABBYY Recording Service as a client on the ABBYY Timeline website. 

Before you begin

Role required: admin

Basic steps

1. Register ABBYY Recording Service as a client on the ABBYY Timeline website and obtain

credentials (Client ID and Client Secret).

For more information, see the 'Registering a New Client on ABBYY Timeline website '

section below. 

2. In the ABBYY Recording Service website specify the connecting details to ABBYY

Timeline using the credentials you obtained in step 1.

For more information, see the 'Configuring connection setting in ABBYY Recording

Service ' section below. 

Registering a New OAuth Client on ABBYY Timeline website

1. Open the ABBYY Timeline website and login. 

2. Go to Account Settings > OAuth tab and click Register client.

3. In the opened registration form, fill in the following fields:

40
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a. App name 

Enter a unique name that identifies the application that you require OAuth access for.

For example, RecordingService.

b. App URL 

Enter the URL, that hosts the ABBYY Recording Service. For example,

https://recorder.myCompany.com

c. Redirect URI 

Enter the callback URL that the authorization server redirects to. Enter the full URL of

the clients requesting access to the resource, appended by /api/auth/callback. For

example, https://recorder.myCompany.com/api/auth/callback

d. Client logo 

This is optional. You may upload an image to use as the application logo.

e. Confidential client 

Select Confidential clients as the ABBYY Recording Service is able to securely

authenticate with the authorization server.

f. Scopes 

Select Read projects and Write projects scope values to request access to submit

data from ABBYY Recording Service to ABBYY Timeline. 

4. Click Register new client and you will be able to see Client ID the auto-generated

unique ID of the application. Copy Client ID and Client Secret fields for use on ABBYY

Recording Service.

Configuring connection setting in ABBYY Recording Service

1. Open ABBYY Recording Service website you installed in "ABBYY Recording Service

installation " step and login.

2. Go to the Settings tab and fill the fields in:

a. Timeline URL

Enter the URI of ABBYY Timeline website.

b. Client ID and Client Secret 

Enter the Client ID and Client Secret you obtain after registering the client in step 4

'Registering a New Client on ABBYY Timeline website'  section.

24

41

https://recorder.myCompany.com
https://recorder.myCompany.com/api/auth/callback


42© 2021 ABBYY Development Inc. 

ABBYY® Timeline 5.1 - Deployment Guide

3. Click Save connection.

Please wait for notification. If the connection is successful, it displays Save. Otherwise, an

error appears: 'The server is unreachable, please notify the administrators and try again

later'.

If connection fails:

a. Check the connection settings you specified above.

b. Make sure the ABBYY Timeline website is available.

c. Check the firewall settings. For more information, see the 'Network Connection

Settings '.

d. Make sure the ports specified during ABBYY Recording Service installation are not

being used by other applications. For more information, see the "How to Check if the

TCP/IP Port is Free ".

Using HTTPS

You can use the HTTPS to secure data transferred between the application components and the

client’s browser.

To configure HTTPS, you need SSL certificates for ABBYY Timeline and ABBYY Recording Service.

You can choose one of the following options:

1. Use SSL certificate issued by the Certification Authority (CA).

This is the recommended approach for the application installation that is intended for a

production environment. The connection to the server will be secure and users will not

get any warnings from the browser.

2. Use a self-signed SSL certificate. 

If you do not have a signed certificate or if you only require a certificate for testing

purposes, use a self-signed SSL certificate. However, in this case users will get warnings

from the web browser about the use of a self-signed certificate as the server will not be

considered secure.

Note. If you install the program in a production environment, it is highly discouraged to

use a self-signed SSL certificate.

Important.

· If you install the program in a production environment, it is strongly recommended to

use HTTPS and highly discouraged HTTP.
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· For interaction between ABBYY Recording Service and ABBYY Timeline, it is

recommended to use the same protocol, for example, HTTP and HTTP or HTTPS and

HTTPS. Make sure that during the ABBYY Timeline installation you specify the same

protocol as specified when installing the ABBYY Recording Service. If you are going to

use ABBYY Timeline in the cloud, please, use HTTPS. 

How to Setup HTTPS for ABBYY Timeline

Below is a general sequence of steps necessary for setting up HTTPS for ABBYY Timeline

component.

Basic steps

1. Obtain an SSL certificate.

2. Extract the certificate and keys from a .pfx file.

Currently, the ABBYY Timeline does not accept .pfx files. You must extract the .cert and

.key files from the .pfx file, so that the certificate and the key files are available

separately.

For more information see "How to extract .cert and .key files from the .pfx ".

3. Setup HTTPS.

You can enable SSL and configure HTTPS on one of the following stages:

§ During ABBYY Timeline installation process

For more information see "How to setup HTTPS during ABBYY Timeline installation".

§ After the ABBYY Timeline installation is completed.

For more information see "How to setup HTTPS without reinstalling ABBYY Timeline".

How to extract .cert and .key files from the .pfx

Prerequisites. Ensure OpenSSL is installed in the server that contains the SSL certificate.

Important. Name your private key and certificate files as server.key and server.cert respectively.

The key and certificate files must be named server.key and server.cert since the ABBYY Timeline

accepts only files with these names.

1. Start OpenSSL from the OpenSSL\bin folder.
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2. Open the command prompt and go to the folder that contains your .pfx file.

3. Run the following command to extract the private key:
openssl pkcs12 -in [yourfile.pfx] -nocerts -out [keyfile-encrypted.key]

You will be prompted to type the import password. Type the password that you used to

protect your keypair when you created the .pfx file. You will be prompted again to

provide a new password to protect the .key file that you are creating. Store the

password to your key file in a secure place to avoid misuse.

4. Run the following command to extract the certificate:

openssl pkcs12 -in [yourfile.pfx] -clcerts -nokeys -out [certificate.cert]

5. Run the following command to decrypt the private key:
openssl rsa -in [keyfile-encrypted.key] -out [keyfile-decrypted.key]

6. Type the password that you created to protect the private key file in the previous step.

7. The .cert file and the decrypted and encrypted .key files are available in the path, where

you started OpenSSL.

8. Rename your .cert and .key files to server.cert and server.key as ABBYY Timeline only

accepts files with these names.

How to setup HTTPS during ABBYY Timeline installation

1. Run the ABBYY-Timeline-5.1.*-installer.exe file and follow the on-screen instructions

in the Installation Wizard. For more information see 'Installing ABBYY Timeline '.

2. Enable SSL between application and client in the Timeline Base URL and Ports

Configuration step:

a. Specify TCP/IP port for the ABBYY Timeline website. For example, 443.

b. Choose Use HTTPS.

c. Provide path to server.cert and server.key files.

3. Setup a network connection for ABBYY Timeline. For more information see 'Network

Connection Settings '.

a. In Windows Firewall, open the rules for inbound ABBYY Timeline connections.

b. Add TCP/IP port specified during the installation process to the exception list.

For example, 443 port.
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4. Check whether HTTPS functions properly

To make sure that HTTPS is functioning properly, open a browser on any computer and

enter {TimelineUrl}:{port} in the address bar, where:

§ {TimelineUrl} is the Base URL you specified during ABBYY Timeline installation  or

the public IP address or the full name of the computer on which the ABBYY Timeline

is installed. 

§ {port} is the custom port assigned to the ABBYY Timeline website during the

installation process. If you are using the default port (80 or 443), you do not need to

add them to the {timelineURL}. By default, TCP/IP port 80 or 443 is used.

Example: https://mytimeline:30443

How to switch from HTTP to HTTPS without reinstallation ABBYY Timeline

If you did not configure HTTPS when installing ABBYY Timeline, you can do it later without

reinstalling ABBYY Timeline. To do this: 

1. Go to the computer on which the ABBYY Timeline is installed.

Note: To perform all activities below, you must be a system administrator of the

computer on which the ABBYY Timeline is installed.

2. Stop timelinepi service using Services snap-in or open Command Prompt as

administrator and use:
sc stop timelinepi

3. Open ABBYY Timeline installation folder and copy the server.cert and server.key to ssl

subfolder.

4. By default, the ABBYY Timeline website use 443 TCP/IP port when using HTTPS.

You can reassign port numbers. For more information see "How to Set a Different

ABBYY Timeline Website Base URL and Port Number "

Then you need to make changes to the appropriate Windows Firewall rules or to the

settings of any other firewall that you are using.

5. Make sure the HTTPS protocol is specified in the BASE_URL variable in the

TimelinePI.xml configuration file. Update base_url with port number in case of custom

port.

Example: BASE_URL=https://mytimeline.com:30443 
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6. Start timelinepi service using Services snap-in or run Command Prompt as

administrator and use:
sc start timelinepi

5. Perform a health check .

How to Setup HTTPS for ABBYY Recording Service

Below is a general sequence of steps necessary for setting up HTTPS for ABBYY Recording Service

during installation process.

1. Obtain an SSL certificate.

The SSL certificate should be installed in Microsoft IIS on the server you plan to install

the ABBYY Recording Service.

2. Run the ABBYY.RecordingService.<version>.exe file and follow the on-screen

instructions in the Installation Wizard. For more information see 'Installing ABBYY

Recording Service '.

However, during the Destination Folder step:

a. Choose Use HTTPS.

b. Select the SSL certificate from the list.

Note. The thumbprint of your certificate you can find in the Internet Information

Services (IIS) Manager: 

i. In the Connections, select the server name (host). 

ii. Open Server Certificates.

iii. Open your certificate details and find Thumbprint. 

3. Setup a network connection for ABBYY Recording Service. For more information see

'Network Connection Settings '.

a. In Windows Firewall, open the rules for inbound ABBYY Recording Service

connections.

b. Add TCP/IP port specified during the installation process to the exception list.

For example, 443 port.
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4. Check whether HTTPS functions properly

To make sure that HTTPS is functioning properly, open a browser on any computer and

enter the following into the navigation bar:

https://{url}:{port}

where:

{url} is the name of the ABBYY Recording Service website.

{port} is the port assigned to the ABBYY Recording Service website during the

installation process. For example, 443.

How to switch from HTTP to HTTPS without reinstallation ABBYY Recording

Service

If you did not configure HTTPS when installing ABBYY Recording Service, you can do it later

using IIS Manager:

1. Select RecordingService site in the Connections panel.

2. Click Bindings… in the Action panel

3. In the Site Bindings windows click Add.

The Add Site Binding windows will open

4. Select HTTPS type and provide an SSL certificate issued to the site URL.

5. Restart the site

Network Connection Settings

The table below lists the ports that are used by default to access ABBYY Timeline components or

for interaction between components. If you are using a software or hardware firewall, make sure

that the exception settings for ABBYY Timeline and ABBYY Recording Service components have

been set up accordingly on the computer on which they installed.

If you reassign port numbers, you will need to make changes to the appropriate Windows Firewall

rules or to the settings of any other firewall that you are using.

Important. 

· ABBYY Recording Service and ABBYY Timeline components must be installed on separate

computers. These components use different versions of PostgreSQL. They cannot be

installed on one computer either.
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· For interaction between ABBYY Recording Service and ABBYY Timeline components, it is

recommended to use the same protocol, for example, HTTP and HTTP, or HTTPS and

HTTPS.

·  If you are going to use ABBYY Timeline in the cloud, please, use HTTPS.

ABBYY Timeline

ABBYY Timeline setup does not create any software or hardware firewall exceptions. You must set

up exception settings to allow interactions between components to take place inside a network.

For example, you create inbound and outbound rules in Windows Firewall. The table below

contains information about the ports that the ABBYY Timeline listens on.

Component

name

Protocol

type

Port Traffic

direction

Use

ABBYY Timeline TCP/IP 80 or the port

used during

the

installation (if

use HTTP)

443 or the

port used

during the

installation (if

use HTTPS)

Inbound HTTP or HTTPS connections to the

ABBYY Timeline website.

PostgreSQL TCP/IP 5432 Inbound Connections to PostgreSQL

database server from the remote

computer where the ABBYY

Timeline is hosted.
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ABBYY Recording Service

Component

name

Protocol

type

Port Traffic

direction

Use

ABBYY Recording

Service

TCP/IP 80

(if use HTTP)

443

(if use HTTPS)

Inbound HTTP or HTTPS connections to

the ABBYY Recording Service

website.

ABBYY Recording

Service

TCP/IP 80

(if use HTTP)

443

(if use HTTPS)

Outbound · Connections to PostgreSQL

database server.

· Connections to ABBYY

Timeline.

PostgreSQL TCP/IP 5432 Inbound Connections to PostgreSQL

database server from the

remote computer where the

ABBYY Recording Service is

hosted.

How to Check if the TCP/IP Port is Free

If the ABBYY Recording Service or ABBYY Timeline website does not open after the installation is

complete, the problem may occur due to the busy TCP/IP port specified during installation. 

To find open ports on a computer and to check what is using specified port, use netstat command

line:

1. Open the Command Prompt (Start > Run > cmd) and use netstat -ano | find /i

"<port_number>".

It will show you all processes that use specified port. Notice the PID (process id) in the right

column.

· -a

Displays all active connections and the TCP and UDP ports on which the computer is

listening.

· -n

Displays active TCP connections and port numbers in numerical form.

If you would like to free the port, go to Task Manager, sort by PID and close those

processes.
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· -o

Displays active TCP connections and includes the process ID (PID) for each connection.

How to Set a Different ABBYY Timeline Website

Base URL and Port Number

The port number used by the ABBYY Timeline website is specified during the ABBYY Timeline

installation. By default, TCP/IP port 80 or 443 is used for the ABBYY Timeline website. You can

change port number later using TimelinePI.xml configuration file:

1. Go to the computer on which the ABBYY Timeline is installed.

Note: To perform all activities below, you must be a system administrator of the

computer on which the ABBYY Timeline is installed.

2. Stop timelinepi service using Services snap-in or open Command Prompt as

administrator and use:
sc stop timelinepi

To ensure the correct operation of the ABBYY Timeline, you need to stop timelinepi

service prior to changing ABBYY Timeline configuration file. 

3. Open Command Line and use netstat -a to get a list of ports and choose an available

port.

4. Go to the ABBYY Timeline installation folder and open TimelinePI.xml file using text

editor.

By default, the program is installed into C:\Program Files\ABBYY Timeline

5. In the TimelinePI.xml configuration file:

a. Find the line contains PROXY_PORT and change the value.

e.g.: <env name="PROXY_PORT" value="8080"/>

If you use HTTPS port, change the value for the PROXY_SSL_PORT option.

e.g.: <env name="PROXY_SSL_PORT" value="30443"/>

b. Find the line contains BASE_URL and add or change the port in the value.

e.g.: 

<env name="BASE_URL" value="https://mytimeline.com:8080"/>

or

<env name="BASE_URL" value="http://mytimeline.com:30443"/>

If you are using the default port (80 or 443), you do not need to add them to the

URL. By default, TCP/IP port 80 or 443 is used.

6. Save the TimelinePI.xml file.
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7. Start timelinepi service using Services snap-in or run Command Prompt as

administrator and use:
sc start timelinepi

Important. If you reassign port numbers, you will need to make changes to the appropriate

Windows Firewall rules or to the settings of any other firewall that you are using. Also,  you will

need to make changes to  BASE_URL

How to Change SMTP Mail Server Configuration

for ABBYY Timeline

SMTP mail server configuring during the ABBYY Timeline installation . You can change your mail

server settings later using TimelinePI.xml configuration file.

To change mail server configuration, perform the following actions:

1. Go to the computer on which the ABBYY Timeline is installed.

Note. To perform all activities below, you must be a system administrator of the

computer.

2. Stop timelinepi service using Services snap-in or open Command Prompt as

administrator and use:
sc stop timelinepi

To ensure the correct operation of the ABBYY Timeline, you need to stop timelinepi

service prior to changing ABBYY Timeline configuration file. 

3. Go to the folder where the ABBYY Timeline is installed and open TimelinePI.xml using

any text editor.

By default, the ABBYY Timeline is installed into C:\Program Files\ABBYY Timeline

4. In the TimelinePI.xml configuration file find the following lines and change their values:

a. <env name="MAIL_SERVER_HOST" value=""/>

This line contains the host of the SMTP mail server, enter the address in the value.

e.g.: <env name="MAIL_SERVER_HOST" value="example.smtp.com"/>

b. <env name="MAIL_SERVER_PORT" value=""/> 

This line contains the port of the SMTP mail server, enter the port in the value.

e.g.: <env name="MAIL_SERVER_PORT" value="465"/>
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c. This line contains the user that will be used to authenticate with the SMTP mail server,

enter the username in the value.

<env name="MAIL_SERVER_USERNAME" value=""/>

e.g.: <env name="MAIL_SERVER_USERNAME" value="example_user"/>

d. <env name="MAIL_SERVER_PASSWORD" value=""/>

This line contains the password of the user that will be used to authenticate with the

mail server, enter the username in the value.

e.g.: <env name="MAIL_SERVER_PASSWORD" value="example_password"/>

e. <env name="MAIL_SERVER_SECURE" value="FALSE"/>

This line contains the option whether to use TLS from the start of the connection. If

you want TLS from the start it should be TRUE otherwise it should be FALSE.

f. <env name="MAIL_SERVER_REQUIRE_TLS" value="FALSE"/>

This line contains the option specifies whether the connection should be established

on an unencrypted channel, then upgrade to a secure connection with a STARTTLS

command. If so, specify TRUE otherwise FALSE. 

g. <env name="MAIL_SERVER_REJECT_UNAUTHORIZED" value="TRUE"/>

This line contains the option to reject unauthorized certificates, for example, self-

signed certificates. In that case, it should be TRUE. If you want to use a self-signed

certificate specify FALSE.

h. <env name="EMAIL_SENDER" value="noreply@example.com"/>

This line contains the email sender address is used to fill the 'From' header field of e-

mails. 

5. Save the TimelinePI.xml file.

6. Start timelinepi service using Services snap-in or run Command Prompt as

administrator and use:
sc start timelinepi

How to Change AD Security Groups that Have

Access to the ABBYY Recording Service

Resources

Active Directory security groups configuring during the ABBYY Recording Service installation .

You can change groups that have full control and/or write access to the ABBYY Recording Service

later using the Appdata.production.json configuration file.

25
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To change Active Directory security groups configuration, perform the following actions:

1. Go to the computer on which the ABBYY Recording Service is installed.

Note. To perform all activities below, you must be a system administrator of the

computer.

2. Go to the folder where the ABBYY Recording Service is installed and open

Appdata.production.json using any text editor.

By default, the component is installed into C:\inetpub\ABBYY Recording Service

3. In the Appdata.production.json file find the ADGroupAccess section and change the

values for the UiAdmin and Recorder parameters:

    "ADGroupAccess": {

    "UiAdmin": "Domain\\UserName",

    "Recorder": "ADGroupName"

    }

Note. Backslashes used in values must be escaped with a backslash.

4. Save the Appdata.production.json file.

5. Restart the ABBYY Recording Service website in the Internet Information Services (IIS)

Manager.

How to Configure and Apply Template

Configure the template to specify what data needs to be logged and how it is to be processed. To

do this, open the ABBYY Recording Service website and go to the Template tab. Here you can

add, change, or remove a template. A Default template is created during the ABBYY Recording

Service installation process. You can add and customize new templates. 

Go to the Templates tab on the ABBYY Recording Service website to see basic information on

templates, review the Default template setting or add a custom template. For detailed information

on the Default template and available settings, see below. All options available in the Default

template you can set in your custom template.

Before you begin

Role required: admin

Note. If your account is not added to the Admin AD Security group specified during ABBYY

Recording Service installation , you will not have access to the site.25
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Basic steps

1. Open the ABBYY Recording Service website and go to Templates.

2. Click Default in the Template name column. Review and modify the options if needed.

Note. The Default template cannot be renamed or deleted.

a. Start recording when assigned to recorder

If you need to start record user actions after you assigned a template to a recorder,

turn this toggle switch on. 

By default, the automatic start record is disabled.

b. Record screenshots

By default, user activity and screenshots of the applications the user uses are

recorded in logs.

Screenshots will help you better understand the scenarios in which these events

occurred when analyzing the recorded events. Disable this option if you do not need

to save screenshots.

c. Obfuscate user data

This option allows to protect sensitive information and ensure data security. By

default, this option is turned on. This means records in text logs are encrypted, and

data in screenshots is blurred.

d. Application list

This option allows you to specify a list of applications to record user activity. By

refining the recording area, you reduce the amount of recorded data, and the

analysis result of the recorded events made in ABBYY Timeline is more accurate. By

default, user activities are recorded across all websites and desktop applications that

users interact with on their computers. If the option is disabled, you can easily read all

the texts and see data in the screenshots. To do this just go to the Logs tab and click

LogID.

i. To prohibit the recording of user activity in a website or desktop application,

switch the Excluded list on and add one or several items.

ii. To track and record user activity only in the specified website or desktop

application, switch the Included list on and add one or several items.

Important. The list of excluded and included websites only works properly in

supported browsers .15
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For details on setting up Excluded and Included lists, see the 'How to setup

Excluded or Included list ' and 'Excluded and included list examples ' sections

below.

e. Transformations

Transformations allow finding and replace text in logs in order to redact sensitive

information, such as email addresses or IDs. This option complements the Obfuscate

user data feature. For example, transformations allow you to replace an URL or

some text in logs that should remain confidential, while obfuscation allows you only

to mask text data or blurs information in pictures.

By default, there are no transforms specified. To add transformations to the template,

add them on the Transformations tab in advance. During adding a transformation,

you must specify:

i. Regular expression 

It will be used to search for text in the recorded logs.

ii. Replacement

It is a string to replace the found text.

Important. Transformations added to a template are applied during the

recording log to which the template is assigned. It is impossible to undo

transformations.

For detailed instructions on using transformation see 'How to Add and Apply

Transformations '.

3. Go to Recorders to assign the template to a recorder instance.

You will see the list of connected recorders.

a. Mark the recorder instance on which you want to set up a template and start

recording.

b. Click Set Template.

In the opened list click the template, and then click Select.

c. The recording runs automatically when the Start recording when assigned to

recorder is enabled in the template. Otherwise, click Start to run the recording.
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How to setup Excluded or Included list

EXCLUDED or INCLUDED LIST enables ABBYY Recorder to specify websites for recording user

activity or prohibit record only on supported browsers . The ABBYY Recorder extension must be

installed on the user's computer to operate properly with browsers.

1. Turn on the EXCLUDED or INCLUDED LIST toggle switch.

2. Click Add item.

3. In the opened Add item window specify websites and/or desktop applications.

You can enter a full path or URL or use a combination of valid literal path and * (asterisk)

wildcard character.

Examples:

§ Full path to the application: 
C:\Program Files\ABBYY Recorder\Abbyy.Recorder.App.exe

§ Using * (asterisk) characters in path: 

· *\Abbyy.Recorder.App.exe

· C:\Program Files\ABBYY*.exe

§ Using * (asterisk) characters in URL:

· https://recordingservice.abbyy.com/*

In this case, user activities are recorded or prohibited across only specified

webpages.

· https://*.abbyy.com/*

In this case, user actions are recorded or prohibited across all sub-domains.

4. Click Save.

Excluded and included list examples

The examples in the table assume that ABBYY Recorder browser extensions are installed on a

user's computer. If the extensions are not installed, user activities are not recorded in Google

Chrome, Microsoft Edge, and Mozilla Firefox browsers.

15
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EXCLUDED LIST INCLUDED LIST Description

- https://*.abbyy.com

/*

Records user activities in all applications, browsers,

and sites that match the https://*.abbyy.com/*

template.

https://*.abbyy.com

/*

- Records user activities in all applications and

browsers. Recording is disabled in the sites that match

the template https: //*.abbyy.com/*.

*\firefox.exe - Records user activities in all applications and browsers

except the Firefox browser.

- *\Chrome.exe Records user activities only in the в Google Chrome

browser. Recording is disabled for other browsers

and applications.

- *\Chrome.exe,

https://*.abbyy.com

/*

Records user activities only in the в Google Chrome

browser and sites that match the specified template.

For example, the following sites will be recorded:

https://help.abbyy.com/,

https://www.abbyy.com/solutions/business-process/ 

Recording is disabled for other browsers and

applications.

*\firefox.exe https://*.abbyy.com

/*

Records user activities in all applications and browsers

except the Firefox browser. Recording in browsers

will be carried out only for sites that match the

https://*.abbyy.com/* template.

- *\chrome.exe,

*\firefox.exe,

*\excel.exe

Records user activities in the Google Chrome and

Firefox browsers and Microsoft Excel. Recording is

disabled for the Microsoft Edge browser and other

applications.

*\teams.exe - Records user activities in all browsers. Recording is

disabled for Microsoft Teams.

https://procurement

.abbyy.ru/*

https://*.abbyy.ru/*,

https://abbyy.ru/*

Records user activities in all applications and

browsers 

https://help.abbyy.com/
https://www.abbyy.com/solutions/business-process/
https://*.abbyy.com/*
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EXCLUDED LIST INCLUDED LIST Description

Recording in browsers will be carried out only for

sites that match the https://*.abbyy.ru/*,

https://abbyy.ru/* templates. Recording is disabled

for https://procurement.abbyy.ru/* site. 

- http*, *\firefox.exe,

*\chrome.exe,

*\edge.exe

Records user activities in Google Chrome, Microsoft

Edge, and Mozilla Firefox browsers. Recording is

disabled for all desktop applications.

Important. It is not recommended to perform the record in messengers, as often

messages have sensitive information. Recording in messengers can affect the

performance of the user's computer as well. We recommend adding the following

messengers to the Excluded list:

· Microsoft Teams

· Slack

· Skype for Business

· Cisco Jabber

· Atlassian HipChat

· IBM Lotus Sametime

· Telegram

· WhatsApp

· Viber

· Discord

· Skype

· Lync

· Brosix

· WeChat

· Facebook Messenger

https://abbyy.ru/*
https://procurement.abbyy.ru/*


59© 2021 ABBYY Development Inc. 

ABBYY® Timeline 5.1 - Deployment Guide

· Blackberry Messenger

· Google Hangouts

· Adium

· Cisco Spark

· Signal

How to Add and Apply Transformations

Transformations complement the Obfuscate user data function and allow you to edit and

anonymize information in the recorded data in order to protect sensitive information.

For example, during the logging process, potentially sensitive information may appear in URLs or

event names. This data can be viewed in the Task Definition Editor after uploading the logs to

ABBYY Timeline. To hide this text from users, you can use transformations.

Important. Be very careful when using.

· Transformations can greatly affect the result of the automatic task definition in ABBYY

Timeline.

· Transformations cannot be undone.

Before applying transformations in production environment, complete the

following steps:

1. Record a representative sample of logs for creating and testing regular expressions.

To do this:

a. Go to the Recorders tab.

b. Select recorder instance.

c. Make sure the correct template is assigned to this instance.

d. Click Start.

2. Examine the data that may appear in logs and select texts that should remain

confidential. To do this:

a. Go to the Logs tab.
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b. Select log and click its LogID.

c. As a result, a window with information about the selected log will open.

This window shows all the events recorded in the current log. The selected event is

highlighted in color, and a screenshot is displayed for it, provided that you had

enabled screenshot recording. The path to the application name or URL is displayed

below the screenshot.

Inspect all event names and text in the URL. There may appear titles, names,

addresses, and other fragments of texts that should remain confidential. Go to the

next step to prepare regular expressions to find and replace all occurrences of the

detected text or URLs.

3. Prepare regular expressions and replacement strings.

Examples:

What to look for Regular expression to

replace

Replacement string

John (J|j)ohn.* FIRST_NAME

john.smith@abbyy.com

ivan.ivanov@abbyy.ru 

\w+.\w+@abbyy\.(com|ru) first.last@abbyy.com

Customer: John Doe Customer:[\s+\w+]+ Customer: Customer's Name
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4. Add transformations and apply them to one or two logs to make sure the changes are

correct.

For details, see 'How to add a new transformation ' and 'Post-recording

transformation ' below.

5. Only if you are satisfied with the changes, apply transformations to all recorded logs, or

add them to the template to transform data on the fly.

How to add a new transformation

1. Go to the Transformations tab.

2. Click Add Transformation.

3. In the opened windows, specify transformation parameters:

a. Regular expression

To search for a text string, enter a regular expression using Regex syntax.

b. Replacement 

To replace instances of the text string in logs with another string, enter the

replacement string.

c. Case insensitive 

By default, the search is case sensitive. If this option is selected, the search will be

case insensitive.

Important. If you edit or delete a transformation, the changes will propagate to all the templates

that include this transformation.

How to apply transformations

On-the-fly transformation

To apply transformations while recording data to logs, add transformations to a template and

assign it to a recorder instance.

1. Go to the Templates tab.

2. Click a template name or create a new one.

61
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3. Click Transformations and then Add item.

4. In the opened window select transformations and click Add.

5. Assign transformations to a recorder instance

For detailed information, see step 3 of the 'How to Configure and Apply Template '

section.

Post-recording transformation

You can apply transformations to recorded logs. To do this, complete the following steps:

1. Go to the Logs tab.

2. Select logs.

3. Click Apply transformation.

4. In the opened form, select transformation and click Apply to selected logs.

Important. If you cancel a running transformation, the transformed portion cannot be undone.

How to Upload Logs to Timeline from a

Recorder Installed in Standalone Mode

If ABBYY Recorder is installed in Standalone mode, logs are not processed and not sent to ABBYY

Recording Service. Thus, it is impossible to use ABBYY Recording Service tools to upload logs to

ABBYY Timeline.

To upload logs to ABBYY Timeline:

1. Open logs folder.

By default, logs are saved to the %appdata%\ABBYY\Recorder\Recorded folder. 

2. Select the folder that contains the Commands and Screenshots subfolders and zip it.

Do the same with all the folders in the logs folder.

Important.

a. ABBYY Timeline accepts only ZIP archives for input.

55
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b. When zipping logs files larger than 2 GB, the Deflate compression method must be

specified in an archiver setting. Use a third-party archiver that allows you to choose

this compression method.

For example, instead of the standard Windows archiver, you can use 7Zip or PeaZip.

3. Open ABBYY Timeline website.

4. Create a new project or open an existing one with enabled Task Mining data source.

(click Project > Details > Data sources and select Task Mining).

5. Select Project > Upload data.

You will see the Upload form.

6. Click Browse File and select ZIP-file you created earlier.

Important! The total size of selected zip files must not exceed 10 GB.

7. Click Upload.

After the upload is complete, go to Home view (select View > Home) and define Tasks.
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Known Issues

Use this section to see if an issue affecting you is already known. 

ABBYY Recorder

Does the log record if the user is inactive?

In case of installing ABBYY Recorder in Server Managed mode, if the user is inactive for more

than 5-7 hours, logging is automatically suspended. After resuming the user's activity, a new log

begins to be recorded.

If installed in Standalone mode, only the user can stop recording. Recording does not stop

automatically.

User is using Internet Explorer 11. Does his activity be recorded?

It is not recommended to record users' activity in the Internet Explorer browser. Event recording in

Internet Explorer is not fully supported, therefore events and/or screenshots may be lost during

recording.

In order to record users' activity in a web browser, use supported browsers with ABBYY Recorder

browser extensions installed.

ABBYY Recorder instance installed in Server Managed mode does not

display in the ABBYY Recording Service

If ABBYY Recorder failed to connect to the ABBYY Recording Service using the URL specified

during ABBYY Recorder installation, it does not display in the ABBYY Recording Service web

application.

To solve this issue:

1. Make sure a user account has been added to the Active Directory group you created

before the ABBYY Recording Service installation .

Add a user account to the Active Directory group if you have not done it before.

14
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2. Check the ABBYY Recorder instance status on the user's computer.

If status is 'Failed to register recorder at: <SomeRecordingServiceUrl>. No such

host is known', make sure ABBYY Recording Service URL is correct. To check and/or

change URL:

a. Open settings.json 

You can find it on the user's computer in the ABBYY Recorder installation folder.

By default, it is installed into C:\Program Files\ABBYY Recorder.

Important! Requires administrator privileges to edit settings.json.

b. Find ServerManagedMode section and check the value specified in Url parameter.

If needs, change the value and restart the ABBYY.Recorder.AutoLauncher service

using Services snap-in (Start > Settings > Control Panel > Administrative Tools >

Services).

Important. Requires administrator privileges to restart service.

ABBYY Recorder Firefox extension limitation

Firefox extension install

ABBYY Recorder setup can install the Firefox extension feature only under a current user account.

If you install this feature, the Firefox browser will launch after the ABBYY Recorder setup is

complete. The Firefox browser is launched under the same account as ABBYY Recorder has just

installed. It asks a user to add the Firefox extension right now. User should allow the installation of

the extension. However, the Firefox extension will be unavailable for other users.

Issue. Users did not detect any new extensions in the Firefox browser as a result of your

administrative setup.

Workaround. Use one of the following methods to solve the issue:

· Add the Firefox extension manually in a user browser.

· Use the Firefox Group Policy to install the Firefox extension, for the Firefox extension

feature to be available to all users.

When installing via Group Policy, specify the path to the Firefox extension: 
%ABBYY Recorder folder%\FirefoxExtension\abbyy_recorder*.xpi
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Contact the vendor for more info at https://github.com/mozilla/policy-

templates/blob/master/README.md#extensionsettings 

Important. In case of ABBYY Recorder upgrade, the Firefox extension needs to be

updated manually.

Firefox extension uninstall

ABBYY Recorder setup cannot remove the ABBYY Recorder Firefox extension.

Each user must remove the ABBYY Recorder Firefox extension from Firefox manually. See How to

Uninstall ABBYY Recorder Firefox Extension  for details.

After a successful Recorder installation, users did not detect the

Recorder extension in a browser, though this feature has been selected

to install

1. Make sure that the user has the ABBYY Recorder extension installed in a supported

browser , and it is enabled. See Installing ABBYY Recorder  for details.

2. If a user removed the Recorder extension from a supported browser manually, then the

Recorder installer will fail to install the Recorder extension later. Contact ABBYY to solve

the issue.

ABBYY Recording Service

ABBYY Recording Service installed successfully, but an error occurred

while starting the ABBYY Recording Service website:

NET :: ERR_CERT_AUTHORITY_INVALID.

If the error NET :: ERR_CERT_AUTHORITY_INVALID is displayed when you try to start the ABBYY

Recording Service website, make sure you specified the correct SSL certificate when installing

ABBYY Recording Service. Use Internet Information Services (IIS) Manager to do this:

1. Open Internet Information Services (IIS) Manager and select RecordingService website.

2. Right-click on a website, and then click Edit Bindings... 

38
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https://github.com/mozilla/policy-templates/blob/master/README.md#extensionsettings
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3. In the Site Bindings window, click Edit...

The Edit Site Binding window will open.

4. In the SSL certificate drop-down list, check the selected SSL certificate. Select another

one if necessary, and then click OK.

5. Restart the RecordingService website for the changes to take effect.

6. Verify the changes by opening the website in a web browser.

I'm trying to start a recording, but the recorder does not change the

status to "record".

A user may forbid event recording by clicking Disable in his/her ABBYY Recorder menu in the

system tray. This will stop record and block recording control on this instance via the ABBYY

Recording Service UI. The recorder continues to display on ABBYY Recording Service website in

the recorders list. Its status is online, but the status does not change to recording after you click

Start and then Refresh List.

To start or resume recording using the ABBYY Recording Service interface, the user must enable

recording by clicking the Enable button in his/her ABBYY Recorder menu in the system tray.

Recording on the selected Recorder has started, but logs are not

reflected in the UI.

After you click the Start button, make sure the recording has launched. To do this click the

Refresh list button and check the recorder status changed to the recording.

Recorded events are saved to logs and sent to the server for processing. When processing is

complete, the logs are displayed on the Logs tab. New log may take some time to display in the

Recordings tab.

What ABBYY Timeline project do logs send to?

You can upload logs only to the ABBYY Timeline project with the Task Mining option is specified

as the data source. We recommend preparing an ABBYY Timeline project for uploading logs in

advance. To do this:
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Open ABBYY Timeline website and create a new or open an existing project with enabled Task

Mining data source.

(click Project > Details > Data sources and select Task Mining).

Upload process consists of the following:

1. Open Logs tab and click Load to project.

This will open ABBYY Timeline login form. 

2. Enter your e-mail and password.

Note. Once you provide credentials, the program will no longer ask for them when

upload logs.

3. In the opened list, select the project for logs to upload and press the Select button.

Click Show Message to check the uploading status.

Logs are partially uploaded, or upload fails.

There are some restrictions to upload logs:

1. Unable to upload logs, if the total number of unique events in logs exceeds 10000.

If the limit exceeds, an attempt to upload logs fails with an error: The selected logs

have more unique events than the allowed limit. 

To solve this issue, reduce the number of logs being uploaded and try again. 

To check the number of unique events in one log:

a. Go to Logs

b. Click logs id and check the UNIQUE EVENTS field.

2. Logs are not fully uploaded if the size of the uploaded screenshots exceeds 25GB.

If the limit exceeds, a message appears: The size of the screenshots exceeded the

maximum limit for the selected logs. Some screenshots will not be uploaded.

This means, text logs were uploaded completely to the ABBYY Timeline project and

image logs were partially uploaded. Screenshots outside 25GB were not uploaded.

To solve this issue, reduce the number of logs being uploaded and try again.
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ABBYY Timeline

The application prompts me to save a suggested task when trying to

clear the start (end) event or set up one in some task definitions.

You can only change the suggested task after it has been saved. Thus, the task becomes custom. 

If the Save suggested task as window appears, it means you are trying to change the suggested

task. Save the task, and then you can add or clear the start (end) events. 
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Technical Support

Should you have any questions regarding the use of ABBYY Timeline, please e-mail the ABBYY

technical support service at support@abbyy.com. Please provide the following information when

contacting technical support:

· your first and last name

· the name of your organization

· your phone number (or fax, or e-mail)

· your ABBYY Timeline version and the build number

· a description of the problem and the full text of the error message (if there was any)

You may also wish to provide any additional information you consider important.

mailto:support@abbyy.com
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